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Démarrer avec la programmation en Python
En utilisant Python avec les produits TI-Nspire™, vous pouvez :

e ajouter des programmes Python aux fichiers TNS,
e créer des programmes Python en utilisant des modeéles,
e communiquer avec d’autres applications TI-Nspire™ afin de partager des données,

e communiquer avec Tl-Innovator™ Hub et Tl-Innovator™ Rover.

L'implémentation de Python dans I’environnement TI-Nspire™ est basée sur
MicroPython, un petit sous-ensemble de la bibliotheque standard Python 3 congue pour
les microcontrdleurs. L'implémentation originale de MicroPython a été adaptée pour
étre utilisée par TI.

Remarque : Certaines réponses numériques peuvent varier par rapport aux résultats
des calculatrices en raison de différences dans les implémentations mathématiques
sous-jacentes.

Python est disponible sur les produits TI-Nspire™ suivants :

Unités Logiciel pour ordinateur

TI-Nspire™ CX Il Logiciel enseignant TI-Nspire™ CX Premium
TI-Nspire™ CX Il CAS Logiciel enseignant TI-Nspire™ CX CAS Premium
TI-Nspire™ CX II-T Logiciel TI-Nspire™ CX version Eléve

TI-Nspire™ CX II-T CAS [ TI-Nspire™ CX CAS Student Software
TI-Nspire™ CX 1I-C
TI-Nspire™ CX 1I-C CAS

Remarque : Dans la plupart des cas, les fonctionnalités sont identiques entre la
calculatrice et les vues logicielles, mais des différences peuvent apparaitre. Ce guide
suppose que vous utilisez la calculatrice ou la vue calculatrice dans le logiciel.

Modules Python

Python dans I’environnement TI-Nspire™ comprend les modules suivants :

Modules standard Modules TI
Mathématiques (math) Tl PlotLib (ti_plotlib)
Nombre aléatoire (random) Tl Hub (ti_hub)
Nombres complexes (cmath) | TI Rover (ti_rover)
Temps (time) Tl System (ti_system)
TI Draw (ti_draw)

Tl Image (ti_image)
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Remarque : Si vous possédez des programmes Python créés dans d’autres
environnements de développement, vous devrez peut-étre les modifier afin de les
exécuter sur la solution Python dans I’environnement TI-Nspire™. Les modules peuvent
utiliser des méthodes, des arguments et un ordonnancement des méthodes différents
dans un programme par rapport aux modules TI. Il convient en général d’étre attentif a
la compatibilité lors de I'utilisation de n'importe quelle version de Python et des
modules Python.

Lors du transfert de programmes Python d’une plate-forme non-Tl a une plate-forme TI
OU d’un produit Tl a un autre, n’oubliez pas que :

e les programmes qui utilisent les fonctionnalités du langage de base et les librairies
standard (math, random, etc.) peuvent étre portés sans modifications ;

e les programmes qui utilisent des bibliothéques spécifiques a une plate-forme,
telles que matplotlib pour PC ou modules Tl, devront étre modifiés avant d’étre
exécutés sur une autre plate-forme. Cela peut étre vrai méme entre les plates-
formes TI.

Comme pour toute version de Python, vous devrez inclure des importations pour utiliser
toutes les fonctions, méthodes ou constantes contenues dans un module donné. Par
exemple, pour exécuter la fonction cos() du module mathématique, utilisez les
commandes suivantes :

>>>from math import *
>>>cos (0)
1.0

Pour une liste des menus avec leurs options et leurs descriptions, veuillez consulter la
section Guide des menus.

Installation d’un programme Python en tant que module
Pour enregistrer votre programme Python en tant que module :

e Dans I’éditeur, sélectionnez Actions > Installer en tant que module Python.
e Dans le Shell, sélectionnez Outils > Installer en tant que module Python.
Apres la sélection, les événements suivants se produisent :

e La syntaxe Python est vérifiée.

e Le fichier est enregistré et déplacé dans le classeur PyLib.

e Une boite de dialogue s’affiche pour confirmer que le fichier a été installé en tant
gue module.

e Le fichier est fermé et le module est prét a I'emploi.

* Le nom du module sera ajouté au menu Plus de modules avec un élément de menu
from <module> import * .

Si vous prévoyez de partager ce module avec d’autres personnes, il est recommandé de
respecter les directives suivantes :

e Ne stockez qu’un seul module par fichier TNS.
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e Le nom du module correspond au nom du fichier TNS (par exemple, le module
"my_program" est dans le fichier "my_program.tns").

e Ajoutez une page Notes avant I’éditeur Python pour décrire I'objectif du module, la
version et les fonctions.

e Utilisez la fonction ver() pour afficher le numéro de version du module.

e (Facultatif) Ajoutez une fonction d’aide pour afficher la liste des méthodes dans la
fonction.
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Espaces de travail Python

Il existe deux espaces de travail pour votre programmation en Python : I’éditeur Python
et la console Python (Shell).

Editeur Python Console Python (Shell)

e (Créer, modifier et sauvegarder des e Exécution des programmes Python

programmes Python e Utile pour tester de petits fragments

e Mise en évidence syntaxique et de codes

auto-indentation e Interaction avec I’historique de la

e Invite de commandes en ligne pour console pour sélectionner les entrées
vous guider avec les arguments de et sorties précédentes en vue de leur
fonction réutilisation

¢ Info-bulles pour indiquer la plage de |e La touche énumere les variables
valeurs possibles utilisateur globales définies dans le
dernier programme exécuté pour une

e La touche [var] énumere les variables Y <
activité donnée

et les fonctions utilisateur globales
définies dans le programme en
cours

e Raccourcis clavier

Remarque : Plusieurs programmes et consoles Python peuvent étre ajoutés a une
activité.

Editeur Python

L’éditeur Python est I’endroit ol vous pouvez créer, modifier et sauvegarder des
programmes Python.

Ajout d’'une page de I’éditeur Python

Pour ajouter une nouvelle page de I'éditeur Python dans I’activité en cours, appuyez sur
et sélectionnez Ajouter Python (Add Python) > Nouveau (New).

1 Add Calculator
£ 2 Add Graphs
3 Add Geometry
B 4 Add Lists & Spreadsheet
) 5 Add Data & Statistics
6 Add Notes

7 Add Vernier DataQuest™
8 AddWidget
@ 9 Add Program Editor »
A Add Python
2 Open...
3 Shell

Vous pouvez créer un programme vierge, ou vous pouvez sélectionner un modele.

Programme vierge Modéle
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[samped ]
L]

oK | Cancel

Elank

New

Name: | |

Type: [Blank Program

oK Cancel

Apreés la création du programme, |’éditeur Python apparait. Si vous avez sélectionné un
modele, les instructions d’'importation nécessaires sont automatiquement ajoutées

(voir ci-dessous).

Remarque : Vous pouvez avoir plusieurs programmes dans un seul fichier TNS, tout
comme pour d’autres applications. Si le programme Python est destiné a étre utilisé
comme module, le fichier TNS peut étre enregistré dans le dossier PyLib. Ce module
peut ensuite étre utilisé dans d’autres programmes et classeurs.

Calculs mathématiques

Simulations aléatoires

) *Templates.py 5/5 [ *Templates.py /6]
# Math Calculations [# Random Simulations

from math import *

frorm math import *
from randorn import *

Graphiques géométriques Traitement d’image
B *Templates.p 5/5 B *Templates.py 606
# Geomety Graphics [ Tmage Pr
from ti_draw import * from ti_image import *
from ti_draw import get_screen_dim
Tracé (x,y) &et texte Partage de données
B *Templates.py 5/5 [ *Templates.py 5/5|
#Ploting (oy) & Te % Data Sharing

import ti_plotiib as plt

from ti_system import *

Projet Tl-Innovator Hub

Codage TI-Rover
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) *Templates.py 99 [ *Templates.py 615
[# Hub Project [# Rover Coding

from ti_hub import * import ti_rover as rv

from math import * from math import *

from time import sleep
from ti_plotlib import text_at,cls
from ti_system import get_key

Ouverture d’un programme Python

Pour ouvrir un programme Python existant, appuyez sur et sélectionnez Insérer
(Insert) > Ajouter Python (Add Python) > Ouvrir (Open). Une liste des programmes
enregistrés dans le fichier TNS s’affiche.

Si la page de I'éditeur utilisée pour créer le programme a été supprimée, celui-ci est
toujours disponible dans le fichier TNS.

Utilisation de I’éditeur Python

En appuyant sur le menu Outils Classeur (Document Tools) s’affiche. Grace a ces
options de menu, vous pouvez ajouter, déplacer et copier des blocs de code pour votre

programme.

Menu Outils du Classeur

[ 1 Actions o 20 1] X m
> 2 Run » b 2 Run , T
E9 3 Edit Ve E0 3 Edit | —
1. 4 Built-ins » B 1 def function: Functions »

V5 Math 3 | 2 retum 2 Control »

@ 6 Random ’ @ 6 Random 3 Ops o

L7 TIPltio > L7 TPl 4 Lss

© 8 TIHWb » © 8 TIHWb 5 Type  *

# 9 TIRover ’ & 9 Tl Rover 6 1B L

& A More Modules ¥ & A More Modules »

vr B Variables 4 vr B Variables »

Les éléments sélectionnés dans les menus du module ajouteront automatiquement un
modele de code a I’éditeur avec des invites de commandes en ligne pour chaque partie
de la fonction. Vous pouvez naviguer d’'un argument a I'autre en appuyant sur
(avancer) ou [eshif)+[tab) (reculer). Des info-bulles ou des listes contextuelles
s’afficheront lorsqu’elles seront disponibles pour vous aider a sélectionner les bonnes
valeurs.

Invites de commandes en ligne  Info-bulles

) *Samples.py 244 B *Samples.py 33
from ti_draw import * from ti_draw import *
def | (argqument): set_color(E,green,blue)
block 55
Listes contextuelles

Espaces de travail Python 6



) *Samples.py 33

from ti_draw import *

Les numéros a droite du nom du programme indiquent le numéro de ligne actuel du
curseur et le nombre total de lignes du programme.

Samples

B Samples.py
ffrom math mport *

=2
y=4.5
z=pi
def 111

retul 2

def 22(n):
return n**3

Les fonctions et variables globales définies dans les lignes au-dessus de la position
actuelle du curseur peuvent étre insérées en appuyant sur et en les sélectionnant
dans la liste.

B Samples.py 1111
from math import *
x=2
Zi:‘s I+ |
fea 12
def 1(n): var x
return n*2 iy

r 2
def 2(n):
return n*]

Lorsque vous ajoutez du code a votre programme, I’éditeur affiche des mots-clés, des
opérateurs, des commentaires, des chaines de caractéres et des indentations de
différentes couleurs pour vous aider a identifier les différents éléments.

[ *Pythagoras.py 99
4ef T(a,b,0):
retUMn(@*2+h*2-cH3)

print('Right triangle")
lse:

else:
print("Non-right triangle")

Sauvegarde et exécution des programmes

Lorsque vous avez terminé votre programme, appuyez sur et sélectionnez Exécuter
(Run) > Vérifier la syntaxe et sauvegarder (Check Syntax & Save). Cela permettra de
vérifier la syntaxe du programme Python et de le sauvegarder dans le fichier TNS.

Remarque : Si des modifications de votre programme n’ont pas été sauvegardées, un
astérisque s’affiche a c6té du nom du programme.

) *Pythagoras.py
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Pour exécuter le programme, appuyez sur et sélectionnez Exécuter (Run) >
Exécuter (Run). Cela exécutera le programme courant dans la page de console Python
suivante ou dans une nouvelle si la suivante n’est pas une page Shell.

Remarque : L’exécution du programme vérifie automatiquement sa syntaxe, puis le
sauvegarde.

Console Python (Shell)

La console Python (Shell) est I'interpréteur qui exécute vos programmes Python,
d’autres fragments de code Python ou de simples commandes.

Code Python Commandes simples

Python Shell 1010
i

>>>for i in range(S):
.. +eprint(*)

Loee

Ajout d’'une page de console Python

Pour ajouter une nouvelle page de console Python dans I’activité en cours, appuyez sur
et sélectionnez Ajouter Python (Add Python) > Shell.

1 Add Calculator
£ 2 Add Graphs
3 Add Geometry
B 4 Add Lists & Spreadsheet
) 5 Add Data & Statistics
6 Add Notes
7 Add Vernier DataQuest™
8 AddWidget
@ 9 Add Program Editor
@ A Add Python

La console Python peut également étre lancée a partir de I’éditeur Python en exécutant
un programme via la touche et en sélectionnant Exécuter (Run) > Exécuter (Run).

*Pythagaras

(@ Python Shell 33
>>>#Running Pythagoras.py

>>>from Pythagoras import *

55>

Utilisation de la console Python (Shell)

En appuyant sur le menu Outils Classeur (Document Tools) s’affiche. Grace a ces
options de menu, vous pouvez ajouter, déplacer et copier des blocs de code.

Menu Outils du Classeur
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B9 2 Edit , B 2 Edit » T
1. 3 Built-ins » R 1 def function0: BT (ERS

4 Math » [ .2 retun 2 Control

5 Random 3 @5 Random 30ps

56 TIPtib  * L6 TPt 4 Lsts

@ 7 TIHub ’ @7 Tl Hub Supe 0D

# 8 Tl Rover ’ # 8 Tl Rover 6 1B L

& 3 More Modules » £ 9 More Modules »

wr A Variables o A Variables ¥

Remarque : Si vous utilisez une méthode de I'un des modules disponibles, veillez a
exécuter d’abord une instruction d’'importation de module comme dans tout
environnement de codage Python.

L'interaction avec les sorties de la console est similaire a I'application Calculs ou vous
pouvez sélectionner et copier les entrées et sorties précédentes pour les utiliser
ailleurs dans la console, I’éditeur ou d’autres applications.

Fléche vers le haut pour sélectionner, puis copier et coller a I’endroit souhaité

[ Python Shell 30|

>>>from math import *
>>>sin(pi/2)
1

Les fonctions et variables globales du dernier programme exécuté peuvent étre
insérées en appuyant sur ou [«n]+(L] et en sélectionnant dans la liste, ou appuyez
sur et sélectionnez Variables > Vars : Dernier programme exécuté.

Pour choisir parmi une liste de fonctions et de variables globales provenant a la fois du
dernier programme exécuté et des modules importés, appuyez sur et sélectionnez
Variables > Vars : Tout.

Menu Variables

1 Tools
2 Edit
3 Built-ins
4 Math

5 Random »
6 Tl PlotLib »
@ 7 TlHub »
@ 8 Tl Rover >
& 9 More Modules ¥
1 Vars: Last Run Program
2 Vars: All

Les variables du dernier programme exécuté  Toutes les variables

*Samples

3 Python Shell 33 A Python Shell fe acosh
>>>#Running Samples.py >>>#Running Samples. 1 asin
>»>from Samples import * >>>from Samples impo fin asinh
Bt >>>| i atan
fio [ it atan2
fin 12 fea atanh
o, x i ceil
12y i copysign
L2z fr cos
fin cosh
o _decraec  ~
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Toutes les pages de console Python de la méme activité partagent le méme état (les
variables définies par |'utilisateur et importées). Lorsque vous enregistrez ou exécutez
un programme Python dans cette activité ou lorsque vous appuyez sur et
sélectionnez Outils (Tools) > Réinitialiser la console (Reinitialize Shell), I’historique de
la console aura alors un fond gris indiquant que I’état précédent n’est plus valide.

Avant la sauvegarde ou la réinitialisation ~ Apres la sauvegarde ou la réinitialisation

*Samples *Samples

>>>#Running Samples.py >>>#Running Samples.py
>>>from Samples import * >>>from Samples import *
>33y >35>y

4.5 45

5> 5oy
| Traceback (most recent call last):

File "< stin>", line 1, in <mocule>
NameError: name 'y isn' defined
55>

Remarque : L'option Outils (Tools) > Effacer I’historique (Clear History) efface
I’écran de toute activité antérieure dans la console, mais les variables sont toujours
disponibles.

Messages

Des messages d’erreur et d’autres informations peuvent s’afficher lorsque vous vous
trouvez dans une session Python. Si une erreur s’affiche dans la console lorsqu’un
programme s’exécute, un numéro de ligne de programme s’affiche. Appuyez sur [cn]
et sélectionnez Accéder a I‘éditeur Python (Go to Python Editor). Dans I’éditeur,
appuyez sur puis sélectionnez Modifier (Edit) > Aller a la ligne (Go to Line).
Saisissez le numéro de la ligne et appuyez sur [enter]. Le curseur s’affichera sur le
premier caractére de la ligne ou I’erreur s’est produite.

Interruption de I’exécution d’un programme

Lors de I'exécution d'une fonction ou d'un programme, le pointeur en forme d'horloge
® s'affiche.

» Pour arréter la fonction ou le programme,

- Windows® : Appuyez sur la touche F12.
- Sur Mac® : Appuyez sur la touche F5.

- Unité : Appuyez sur la touche [@fon].
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Guide des menus Python

Cette section énumere tous les menus et les options de menu de I’éditeur et de la
console Python. Elle fournit une bréve description de chacun élément.

Remarque : Pour les options de menu dotées de raccourcis clavier, les utilisateurs de
Mac® doivent remplacer Ctrl par 3 (Cmd) partout ou il est utilisé. Pour obtenir une
liste compléete des raccourcis pour le logiciel et les unités TI-Nspire™, consultez le
Guide numérique de la technologie TI-Nspire™.

Menu ACtioNS . 12
Menu Exécuter (RUN) .. 13
Menu OULIlS .. e 14
Menu Edition (Edit) - ... . 15
Menu Commandes natives (Built-ins) ... ... ... 17
Menu Mathématiques (Math) ... . 20
Menu Nombre aléatoire (Random) . ... .. 22
Menu Tl PlotLib .. 23
Menu TIHUD . 25
Menu Tl ROVer e 38
Menu nombres complexes (Complex Math) ... . . . .. . . ... 46
1Y/ =T O I T = 47
Menu Tl SYStemM e 48
Menu Tl DraW . 50
Menu Tl Image e 53
Menu Variables ... e 55
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Menu Actions

Remarque : Cela s’applique uniquement a I’éditeur.

Elément

descriptions

Nouveau (New)

Ouvre la boite de dialogue Nouveau (New) : elle
permet de saisir le nom du nouveau programme et
d’en sélectionner le type.

Ouvrir

Ouvre une liste des programmes disponibles dans le
classeur courant.

Créer une copie (Create Copy)

Ouvre la boite de dialogue Créer une copie (Create
Copy) : elle permet d’enregistrer le programme
courant sous un autre nom.

Renommer Ouvre la boite de dialogue Renommer (Rename) :
elle permet de renommer le programme courant.

Fermer Ferme le programme courant.

Parameétres Ouvre la boite de dialogue Réglages (Settings) : elle

permet de modifier la taille de la police pour
I’éditeur et la console (Shell).

Installer en tant que module
Python

Vérifie la syntaxe Python du fichier TNS actuel et le
déplace vers le dossier PyLib.

Guide des menus Python
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Menu Exécuter (Run)

Remarque : Cela s’applique uniquement a I’éditeur.

Raccourcis
Elément clavier descriptions
Exécuter Ctrl+R Vérifie la syntaxe du programme,
I'enregistre puis I’exécute dans une
console Python.
Vérifier la syntaxe et enregistrer | Ctrl+B Vérifie la syntaxe et enregistre le
(Check Syntax & Save) programme.
Accéder au Shell (Go to Shell) N/D Active la console (Shell) liée au

programme en cours ou ouvre une
nouvelle page du Shell a c6té de
I’éditeur.
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Menu Outils

Remarque : Cela s’applique uniqguement a la console (Shell).

Raccourcis

Elément clavier descriptions

Réexécuter le dernier Ctrl+R Réexécute le dernier programme associé a

programme la console en cours.

Accéder a I’éditeur N/D Ouvre la page de I'éditeur relative ala

Python console en cours.

Exécuter N/D Ouvre une liste des programmes disponibles
dans le classeur courant.
Aprés la sélection, le programme choisi est
exécuté.

Effacer historique N/D Efface I’historique de la console en cours,
mais ne réinitialise pas la console.

Réinitialiser la console N/D Réinitialise I’état de toutes les pages
ouvertes de la console pour I’activité en
cours.
Toutes les variables définies et les fonctions
importées ne sont plus disponibles.

dir() N/D Affiche la liste des fonctions dans le module
spécifié lorsqu’il est utilisé apres
I’instruction d’importation.

From PROGRAM import * | N/D Ouvre une liste des programmes disponibles
dans le classeur courant.
Aprés la sélection, I'instruction
d’importation est collée dans la console.

Installer en tant que N/D Activé uniquement pour les modules au

module Python

format binaire. Déplace le fichier TNS actuel
vers le dossier PyLib.

Guide des menus Python
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Menu Edition (Edit)

Remarque : Ctrl+A sélectionne toutes les lignes de code ou les données de sortie afin
de les couper ou de les supprimer (éditeur uniqguement), ou de les copier-coller

(éditeur et console).

Elément

Raccourcis
clavier

descriptions

Indentation

TAB*

Indente le texte sur la ligne en cours ou
sur les lignes sélectionnées.

* Si des invites de commandes en ligne
sont incompletes, TAB passera a l'invite
suivante.

Désindentation

Maj+TAB**

Désindente le texte sur la ligne en cours
ou sur les lignes sélectionnées.
* Si des invites de commandes en ligne

sont incomplétes, Maj+TAB passera a
I'invite précédente.

Commenter/Décommenter

Ctrl+T

Ajoute/supprime le symbole
commentaire au/du début de la ligne en
cours.

Insérer une chaine de
caractéres de plusieurs
lignes

N/D

(éditeur uniquement) Insere un modele
de chaine de caractéres de plusieurs
lignes.

Rechercher

Ctrl+F

(éditeur uniquement) Ouvre la boite de
dialogue Rechercher (Find) et recherche
la chaine saisie dans le programme
courant.

Remplacer

Ctrl+H

(éditeur uniquement) Ouvre la boite de
dialogue Remplacer (Replace) et
recherche la chaine saisie dans le
programme courant.

Aller alaligne

Ctrl+G

(éditeur uniquement) Ouvre la boite de
dialogue Aller a la ligne (Go to Line) et
saute a la ligne spécifiée dans le
programme courant.

Début de ligne

Ctrl+8

Déplace le curseur au début de la ligne
courante.

Fin de ligne

Ctrl+2

Déplace le curseur a la fin de la ligne
courante.

Aller au début (Jump to
Top)

Ctrl+7

Déplace le curseur au début de la
premiere ligne du programme.

Aller ala fin (Jump to

Ctrl+1

Déplace le curseur a la fin de la derniere
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Elément

Raccourcis
clavier

descriptions

Bottom)

ligne du programme.

Guide des menus Python
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Menu Commandes natives (Built-ins)

Fonctions
Elément descriptions
def function(): Définit une fonction qui dépend de variables spécifiées.
return Définit la valeur générée par une fonction.

Contréle (Control)

Elément descriptions

if.. Instruction conditionnelle.
if..else.. Instruction conditionnelle.
if..elif..else.. Instruction conditionnelle.

for index in range(size):

Itére sur une plage.

for index in range(start,stop):

Itére sur une plage.

for index in range(start,stop,step):

Itére sur une plage.

for index in list:

Itére sur les éléments d’une liste.

while.. Exécute les instructions dans un bloc de code
jusgu’a ce qu’une condition soit évaluée a Faux.
elif: Instruction conditionnelle.
else: Instruction conditionnelle.
Ops
Elément descriptions
X=y Définit la valeur de la variable.
X==y Colle I'opérateur de comparaison « égal a » (==).
xl=y Colle I'opérateur de comparaison « différent de » (!=).
x>y Colle I'opérateur de comparaison « strictement supérieur a » (>).
x>=y Colle I'opérateur de comparaison « supérieur ou égal a » (>=).
X<y Colle I'opérateur de comparaison « strictement inférieur a » (<).
X<=y Colle I'opérateur de comparaison « inférieur ou égal a » (<=).
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Elément descriptions

et Colle I'opérateur logique « et » (and).

—ou— Colle I'opérateur logique « ou » (or).

non Colle I'opérateur logique « non » (not).

Vrai Colle la valeur booléenne Vraie (True).

Faux Colle la valeur booléenne Faux (False).
liste

Elément descriptions

0

Colle les crochets ([]).

list() Convertit une séquence en type « liste ».

len() Renvoie le nombre d’éléments de la liste.
max() Renvoie la valeur maximale de la liste.

min() Renvoie la valeur minimale de la liste.
.append() La méthode rajoute un élément a une liste.
.remove() La méthode supprime la premiére instance d’un

élément d’une liste.

range(start,stop,step)

Renvoie un ensemble de nombres.

for index in range(start,stop,step)

Utilisé pour itérer sur une plage.

.insert() La méthode ajoute un élément a la position
spécifiée.

.split() La méthode renvoie une liste dont les éléments
sont séparés par le délimiteur spécifié.

sum() Renvoie la somme des éléments d’une liste.

sorted() Renvoie une liste triée.

.sort() La méthode trie une liste en place.

Type

Elément descriptions

int() Renvoie une partie entiere.

float() Renvoie un nombre a virgule flottante.
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Elément

descriptions

round(x,ndigits) | Renvoie une valeur a virgule flottante arrondie au nombre de

chiffres spécifié.

str() Renvoie une chaine de caractéres.
complex() Donne un nombre complexe.
type() Renvoie le type de I'objet.
E/S
Elément | descriptions
print() Affiche I’argument sous forme d’une chaine de caractéres.
input() Invite I"utilisateur a saisir des données.
eval() Evalue une expression représentée sous forme d’une chaine de caractéres.
format() | La méthode formate la chaine de caracteres spécifiée.
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Menu Mathématiques (Math)

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Calculs mathématiques (Math
Calculations). Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from math import * | Importe toutes les méthodes (fonctions) du module math.

fabs() Renvoie la valeur absolue d’un nombre réel.
sqrt() Renvoie la racine carrée d’un nombre réel.
exp() Renvoie e**x.

pow(x,y) Renvoie x élevé a la puissance vy.

log(x,base) Retourne le logpase (X).

log(x) sans base donne le logarithme népérien de x.

fmod(x,y) Renvoie la valeur de x modulo y. A utiliser lorsque x et y sont
des nombres en virgule flottante.

ceil() Renvoie le plus petit entier supérieur ou égal a un nombre réel.

floor() Renvoie le plus grand nombre entier inférieur ou égal a un
nombre réel.

trunc() Troncature d’'un nombre réel, donne un nombre entier.

frexp() Retourne la mantisse et I’exposant d’un nombre x, comme paire

(y,n) telle que x ==y * 2**n,

Const
Elément descriptions
C: Returns value for the constant e.
pi Returns value for the constant pi.
Zoom trigo
Elément descriptions
radians() Convertit un angle de degrés en radians.
degrees() Convertit un angle de radians en degrés.
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Elément descriptions

sin() Renvoie le sinus de I’argument exprimé en radians.

cos() Renvoie le cosinus de I'argument exprimé en radians.
tan() Renvoie la tangente de I'argument exprimé en radians.
asin() Renvoie I’Arc sinus de I'argument exprimé en radians.
acos() Renvoie I’Arc cosinus de |’argument exprimé en radians.
atan() Renvoie I’Arc tangente de I’argument exprimé en radians.
atan2(y,x) Renvoie I’Arc tangente de y/x exprimé en radians.
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Menu Nombre aléatoire (Random)

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Simulations aléatoires (Random
Simulations). Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from random import * Importe toutes les méthodes du module nombres
aléatoires.

random() Renvoie un nombre a virgule flottante compris entre 0 et
1,0.

uniform(min,max) Renvoie un nombre aléatoire x (a virgule flottante) tel que
min <= X <= max.

randint(min,max) Renvoie un nombre aléatoire entier compris entre min et
max.

choice(sequence) Renvoie un élément aléatoire d’une séquence non vide.

randrange(start,stop,step) | Renvoie un nombre aléatoire d’une plage comprise entre
« start » et « stop » avec un pas « step ».

seed() Initialise le générateur de nombres aléatoires.
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Menu TI PlotLib

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Tracé (x,y) et texte (Plotting (x,y) & Text).
Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

import ti_plotlib as plt | Importe toutes les méthodes (fonctions) du module ti_plotlib
dans I’espace de nom « plt ». Par conséquent, tous les noms
de fonctions collés a partir des menus seront précédés de

« plt. ».
Config
Elément descriptions
cls() Efface la zone de représentation graphique.
grid(x-scale,y-scale,"style") Affiche une grille basée sur les échelles spécifiées

pour les axes des x (x-scale) et des y (y-scale).

window(xmin,xmax,ymin,ymax) | Définit la fenétre de représentation graphique en
faisant correspondre I'intervalle horizontal (xmin,
xmax) et I'intervalle vertical (ymin, ymax) spécifiés a
la zone graphique allouée (pixels).

auto_window(x-list,y-list) Met automatiquement a I’échelle la fenétre
graphique pour qu’elle corresponde a la plage de
données comprises dans les listes x (x-list) et y (y-list)
spécifiées dans le programme, préalablement a la
fonction auto_window().

axes("mode") Affiche les axes sur la fenétre spécifiée dans la zone
graphique.
labels("x-label","y-label",x,y) Affiche les noms des axes x (x-label) et y (y-label) sur

la représentation graphique aux positions définies
respectivement par les arguments x et y.

title("title") Affiche le titre (title) centré sur la ligne supérieure
de la fenétre.

show_plot() Affiche le tracé en mémoire tampon.

Les fonctions use_buffer() et show_plot() sont utiles
lorsque I’affichage de plusieurs objets a I’écran
risque de provoquer des problémes des
ralentissements (dans certains cas).

use_buffer() Active une mémoire tampon hors écran pour
accélérer le tracé.
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Ponctuation

Elément

descriptions

color(red,green,blue)

Définit la couleur pour tous les graphiques/graphes
suivants.

cls()

Efface la zone de représentation graphique.

show_plot()

Exécute I'affichage de la représentation graphique tel
qu’elle est configurée dans le programme.

scatter(x-list,y-list," mark")

Trace une séquence de paires ordonnées a partir des
listes de coordonnées x (x-list) et y (y-list) avec le style
de marquage (mark) spécifié.

plot(x-list,y-list," mark")

Trace une ligne en utilisant des paires ordonnées des
listes de coordonnées x (x-list) et y (y-list) spécifiées.

plot(x,y,"mark")

Trace un point en utilisant les coordonnées x et y avec
le style de marquage (mark) spécifié.

line(x1,y1,x2,y2,"mode")

Trace un segment de droite allant de (x1,y1) a (x2,y2).

lin_reg(x-list,y-list,"display")

Calcule et dessine le modéle de régression linéaire,
ax+b, des listes x (x-list) et y (y-list).

pen("size","style")

Définit I’apparence de toutes les courbes suivantes
jusqu’a ce que la fonction pen() suivante soit exécutée.

text_at(row,"text","align")

Affiche le texte (text) dans la zone graphique avec
I’alignement (align) spécifié.

Propriétés

Elément | descriptions

xmin Variable spécifiée pour les arguments de fenétre définis comme plt.xmin.

Xmax Variable spécifiée pour les arguments de fenétre définis comme plt.xmax.

ymin Variable spécifiée pour les arguments de fenétre définis comme plt.ymin.

ymax Variable spécifiée pour les arguments de fenétre définis comme plt.ymax.

m Apres I'exécution de plt.linreg() dans un programme, les valeurs calculées
de la pente m et de I'ordonnée a I'origine b, sont stockées dans plt.m et
plt.b.

b Aprés 'exécution de plt.linreg() dans un programme, les valeurs calculées
de la pente a et de I'ordonnée a I'origine b, sont stockées dans plt.a et
plt.b.
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Menu Tl Hub

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Projet hub (Hub Project). Ceci garantit
que tous les modules nécessaires sont importés.

Elément

descriptions

from ti_hub import *

Importe toutes les méthodes du module ti_hub.

Dispositifs intégrés du hub > Sortie couleur

Elément

descriptions

rgb(red,green,blue)

Définit la couleur de la DEL RGB.

blink(frequency,time)

Définit la fréquence (frequency) et la durée (time) de
clignotement pour la couleur sélectionnée.

off()

Eteint la DEL RGB.

Dispositifs intégrés au Hub (Hub Built-in Devices) > Sortie lumiére (Light Output)

Elément descriptions
on() Allume la DEL.
off() Eteint la DEL.

blink(frequency,time)

Définit la fréquence (frequency) et la durée (time) de
clignotement de la DEL.

Dispositifs intégrés au Hub (Hub Built-in Devices) > Sortie audio (Sound Output)

Elément

descriptions

tone(frequency,time)

Joue une tonalité ala fréquence spécifiée pendant le
temps spécifié.

note("note",time)

Joue la note spécifiée pendant la durée (time)
spécifiée.

La note est spécifiée au moyen de son nom (en anglais)
et d’'une octave. Par exemple : A4, C5.

Les noms des notes (en anglais) sont C, CS, D, DS, E, F,
FS, G, GS, A, AS et B.
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Elément

descriptions

Les octaves sont comprises entre 1 et 9 (inclus).

tone(frequency,time,tempo)

Joue une tonalité a la fréquence spécifiée pendant le
temps et au tempo spécifiés.

Le tempo définit le nombre de bips par seconde entre
0 et 10 (inclus).

note("note",time,tempo)

Joue la note spécifiée pendant le temps et au tempo
spécifiés.

La note est spécifiée au moyen de son nom (en anglais)
et d’'une octave. Par exemple : A4, C5.

Les noms des notes (en anglais) sont C, CS, D, DS, E, F,
FS, G, GS, A, AS et B.

Les octaves sont comprises entre 1 et 9 (inclus).

Les valeurs de tempo sont comprises entre 0 et 10
(inclus).

Dispositifs intégrés au Hub (Hub Built-in Devices) > Entrée luminosité (Brightness

Input)

Elément descriptions

measurement() | Lit le capteur de LUMINOSITE (niveau de lumiére) intégré et

retourne la valeur relevée.

La plage par défaut est de 0 a 100. Cela peut étre modifié via la
fonction range().

range(min,max) | Définit la plage pour la configuration des relevés du capteur de

niveau de lumiere.

Si les deux valeurs sont manquantes, ou si elles sont définies sur une
valeur évaluée a None, alors la plage de luminosité par défaut (de O
a100) est utilisée.

Ajouter un dispositif d’entrée (Add Input Device)

Ce menu contient une liste des capteurs (dispositifs d’entrée) pris en charge par le
module ti_hub. Toutes les options du menu collent le nom de I'objet et attendent une
variable et un port utilisés avec le capteur. Chaque capteur posséde une méthode
measurement() qui retourne la valeur mesurée.

Elément

descriptions

DHT (Capteur de température et d’humidité) (DHT, Digital HumigiRe 8vdEmyme liste

comportant la
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Elément

descriptions

température,
I"humidité, le type de
capteur actuels et le
dernier état mis en
mémoire.

Ranger (Capteur de distance)

Renvoie la mesure de

la distance courante

issue du capteur de

distance a ultrasons

spécifié.

¢ measurement_
time() : renvoie
le temps pris par
le signal
ultrasonique pour
atteindre I'objet
(le « temps de
vol »).

Niveau de lumiere

Renvoie le niveau de
luminosité issu du
capteur de lumiére
externe (luminosité).

température

Renvoie la lecture de
la température issue
du capteur de
température externe.

La configuration par
défaut prend en
charge le capteur de
température Seeed
sur les ports IN 1,

IN 2 ou IN 3.

Pour utiliser le
capteur de
température Tl LM19
du pack de platines
d’essais TI-Innovator™
Hub, modifiez le port
sur la broche BB en
service et utilisez un
argument optionnel

« TIANALOG ».

Exemple :
mylm19=temperatur
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Elément descriptions
e("BB
5","TIANALOG")
Humidité Renvoie la lecture du

capteur d’humidité.

Champ magnétique

Détecte la présence
d’un champ
magnétique.

La valeur seuil pour
déterminer la
présence du champ
est fixée par la
fonction trigger().

La valeur par défaut
du seuil est de 150.

App Vernier

Lit la valeur du
capteur analogique
Vernier spécifié dans
la commande.

La commande prend

en charge les

capteurs Vernier
suivants :

e température :
capteur de
température en
acier inoxydable.

e niveaude
lumiére : capteur
de niveau de
lumieére TI.

e pression:
capteur de
pression de gaz
d'origine.

e pression:
capteur de
pression de gaz
plus récent.

e pH: capteur de
pH.

e forcelO : réglage
+10 N, capteur
de force double
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Elément

descriptions

échelle.

e force50 : réglage
+50 N, capteur
de force double
échelle.

e accélérometre :
accélérometre
Low-G.

e générique :
permet le réglage
d’autres capteurs
non pris en
charge
directement
comme ci-dessus
et 'utilisation de
I’API calibrate()
ci-dessus pour
définir des
coefficients
d’équation.

Entrée analogique

Prend en charge
I’utilisation de
dispositifs génériques
d’entrée analogique.

Entrée numérique

Renvoie |'état actuel
de la broche
numérique
connectée a I'objet
DIGITAL ou I'état de
mise en cache de la
valeur de sortie
numérique DEFINIE
en dernier lieu sur
I’objet.

Potentiomeétre

Prend en charge un
potentiomeétre.

La plage du capteur
peut étre modifiée
par la fonction range

(-

Thermistor

Lit le thermistor.
Les coefficients par
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Elément descriptions

défaut sont adaptés
au thermistor inclus
dans le pack de
platine d’essais TI-
Innovator™ Hub,
lorsqu’il est utilisé
avec un résistor fixe
de 10 kQ.

Un nouveau jeu de
coefficients
d’étalonnage et une
résistance de
référence pour le
thermistor peuvent
étre configurés a
I’aide de la fonction

calibrate().

Intensité sonore Prend en charge les
capteurs de niveau
sonore.

Entrée couleur Fournit des interfaces

a un capteur
colorimétrique
d’entrée connecté au
port 12C.

La broche bb_port
est utilisée en plus
du port 12C pour
controéler la DEL du
capteur de couleur.

e color_number():
Retourne une
valeur comprise
entre 1 et 9 qui
représente la
couleur détectée
par le capteur.
Les chiffres
représentent les
couleurs selon les
correspondances
suivantes :

1: Rouge
2: Vert
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Elément

descriptions

3: Bleu
: Cyan
: Magenta

4

5

6: Jaune

7: Noir

8 : Blanc

9: Gris

e red(): Retourne
une valeur de 0 a
255 qui
représente
I'intensité du
niveau de
couleur ROUGE
détecté.

e green():
Retourne une
valeur de 0 a 255
qui représente
I'intensité du
niveau de
couleur VERTE
détecté.

e blue(): Retourne
une valeur de 0 a
255 qui
représente
I'intensité du
niveau de
couleur BLEUE
détecté.

e gray(): Retourne
une valeur de 0 a
255 qui
représente le
niveau de gris
détecté, ou 0
correspond au
noir et 255 au
blanc.

Port BB

Permet d’utiliser les
10 broches du port
BB comme un port
d’entrée/sortie
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Elément descriptions

numérique combiné.
Les fonctions
d’initialisation
disposent d’un
parameétre « masque
(mask) » optionnel
qui permet d’utiliser
le sous-ensemble de

10 broches.
e read_port(): Lit
les valeurs

courantes sur les
broches d’entrée
du port BB.

e write_port
(value): Regle la
broche de sortie
alavaleur
spécifiée (la
valeur est
comprise entre 0
et 1023). Notez
que la valeur est
également
ajustée par
rapport ala
valeur du masque
dans I'opération
var=bbport(mask),
si un masque a
été fourni.

Hub Time Permet d’accéder au
timer interne (en
millisecondes).

TI-RGB Array Fournit des fonctions
pour la
programmation de Tl-
RGB Array.

La fonction
d’initialisation
accepte un
parameétre optionnel
« LAMP » pour
activer le mode
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Elément

descriptions

haute luminosité de
TI-RGB Array. Il
requiert une
alimentation
électrique externe.

set(led_position,
r,g,b): Regle la
valeur r,g,b
spécifiée pour la
DEL située ala
position (led_
position)
spécifiée (0-15).
r, g et b sont des
valeurs comprises
entre 0 et 255.

set(led_
list,red,green,blu
e): Définit les
DEL de la « led_
list » sur la
couleur spécifiée
« rouge »,

«vert » ou

« bleu ». La

« led_list » est
une liste Python
qui inclut les
index des DEL de
0a15. Par
exemple, set
([0,2,4,6,15], 0, O,
255) définira les
DELO, 2,4, 6 et
15 sur le bleu.
set_all(r,g,b):
Reégle la méme
valeur r,g,b pour
toutes les DEL
RGB de la
matrice.
all_off(): Eteint
toutes les DEL
RGB de la
matrice.
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Elément

descriptions

measurement():
Retourne la
valeur
approximative du
courant
consommé (en
milliampéres) sur
Tl-Innovator™ par
la matrice RGB.

pattern(pattern):
L’argument

« pattern » est
une valeur
binaire de 16 bits
(de 0 a 65 535),
ou lavaleur « 1 »
active le pixel
correspondant.
Les DEL sont
allumées en
ROUGE avec une
valeur de niveau
MLI de 255.

pattern
(value,red,green,
blue): Définit les
DEL caractérisées
par le « modele »
sur la couleur
spécifiée

« rouge »,

«vert » ou

« bleu ».

Ajouter un dispositif de sortie

Ce menu contient une liste des dispositifs de sortie pris en charge par le module ti_
hub. Toutes les options du menu collent le nom de I'objet et attendent une variable et
un port utilisés avec le dispositif.

Elément descriptions
VOYANT Fonctions de contrdle des DEL connectées externes.
RVB Prise en charge du contréle des DEL RGB externes.
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Elément

descriptions

TI-RGB Array

Fournit des fonctions pour la programmation de TI-RGB Array.

Haut-parleur

Fonctions de prise en charge d’un haut-parleur externe avec le
Tl-Innovator™ Hub.

Les fonctions sont les mémes que celles relatives au « son »
décrites plus haut.

Puissance

Fonctions de contréle des alimentations externes avec le TI-
Innovator™ Hub.

e set(value): Régle le niveau de puissance a la valeur (value)
spécifiée, entre 0 et 100.

e on(): Régle le niveau de puissance a 100.
o off(): Régle le niveau de puissance a 0.

Servomoteur continu

Fonctions de contrdle des servomoteurs continus.

e set_cw(speed,time): Le servomoteur tournera dans le
sens des aiguilles d’une montre a la vitesse (speed)
spécifiée (0-255) et pendant la durée (time) spécifiée (en
secondes).

e set_ccw(speed,time): Le servomoteur tournera dans le
sens inverse des aiguilles d’'une montre a la vitesse (speed)
spécifiée (0-255) et pendant la durée (time) spécifiée (en
secondes).

e stop(): Arréte le servomoteur continu.

Sortie analogique

Fonctions pour I'utilisation de dispositifs génériques d’entrée
analogique.

Moteur vibrant

Fonctions de contréle des moteurs vibrants.

o set(val): Regle I'intensité du moteur vibrant au niveau
« val » (0-255).

e off(): Eteint le moteur vibrant.
e on(): Met en marche le moteur vibrant au niveau le plus

élevé.
Relais Interfaces de controle des relais.
e on(): Régle le relais sur I’état ON.
o off(): Régle le relais sur I’état OFF.
Servo Fonctions de contréle des servomoteurs.
* set_position(pos): Regle la position angulaire (pos) du
servomoteur entre -90° et +90°.
e zero(): Regle le servomoteur angulaire sur la position zéro.
Squarewave Fonctions de génération d’un signal carré.

e set(frequency,duty,time): Regle le signal carré de sortie
avec un rapport cyclique (duty) par défaut de 50 % (s'il
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Elément descriptions

n’est pas spécifié) et une fréquence de sortie spécifiée par
« frequency ». La fréquence peut étre comprise entre 1 et
500 Hz. Le rapport cyclique, s'il est spécifié, peut étre
compris entre 0 et 100 %.

off(): Désactive le signal carré.

Sortie numérique Interfaces de contréle d’une sortie numérique.

set(val): Regle la sortie numérique a la valeur spécifiée
par « val » (0 ou 1).

on(): Regle la sortie numérique a un niveau haut (1).
off(): Regle la sortie numérique a un niveau bas (0).

Port BB Fournit des fonctions pour la programmation de TI-RGB Array.

Voir les détails ci-dessus.

Commandes

Elément

descriptions

sleep(seconds)

Interrompt le programme pendant le nombre spécifié de
secondes.

Importé depuis le module « temps ».

text_at(row,"text","align")

Affiche, dans la zone de graphe, le texte (text) spécifié
avec l'alignement (align) spécifié.
Fait partie du module ti_plotlib.

cls()

Efface I’écran de la console (Shell) pour une
représentation graphique.

Fait partie du module ti_plotlib.

while get_key() != "esc":

Exécute les commandes dans la boucle « while » jusqu’a
ce que la touche d’échappement « esc » soit enfoncée.

get_key()

Retourne une chaine représentant la touche enfoncée.
La touche « 1 » retourne « 1 », la touche d’échappement
retourne « esc », etc.

Lorsque la fonction est appelée sans parametres (get_key
(), elle retourne immédiatement la chaine de caractéres
vide (").

Lorsque la fonction est appelée avec un parameétre (get_
key(1)), elle attend qu’une touche soit enfoncée.

Fait partie du module ti_system.
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Ports

Ce sont les ports d’entrée et de sortie disponibles sur le TI-Innovator™ Hub.

“Elément
out1
out2
ER
INT
N2
N3
BBl
BB2
BB3
8BB4
BBS
BB6
BB7
BB8
BB9
BB10
“Port12C
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Menu Tl Rover

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Codage du Rover (Rover Coding). Ceci
garantit que tous les modules nécessaires sont importés.

Elément

descriptions

import ti_rover as rv

Importe toutes les méthodes (fonctions) du module ti_rover
dans I’espace de nom « rv ». Par conséquent, tous les noms de
fonctions collés a partir des menus seront précédés de « rv. ».

Déplacement

Elément

descriptions

forward(distance)

Fait avancer le Rover de la distance spécifiée en unités de
grille.

backward(distance)

Fait reculer le Rover de la distance spécifiée en unités de
grille.

left(angle_degrees)

Fait tourner le Rover a gauche de I'angle spécifié en
degrés.

right(angle_degrees)

Fait tourner le Rover a droite de I’angle spécifié en
degrés.

stop()

Arréte immédiatement tout mouvement en cours.

stop_clear()

Arréte immédiatement tout mouvement en cours et
efface toutes les commandes en attente.

resume() Reprend le traitement des commandes.

stay(time) Le Rover est immobilisé pendant la durée spécifiée en
secondes (facultatif).
Si aucune durée n’est spécifiée, le Rover est immobilisé
pendant 30 secondes.

to_xy(x,y) Déplace le Rover a la position de coordonnées (x,y) sur la

grille virtuelle.

to_polar(r,theta_degrees) | Déplace le Rover a la position en coordonnées polaires {r,

théta) sur la grille virtuelle.
L’angle est spécifié en degrés.

to_angle(angle,"unit")

Fait tourner le Rover de I’angle spécifié dans la grille
virtuelle.

L’angle est défini par rapport a un angle nul qui pointe
vers le bas de I’axe des x dans la grille virtuelle.
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Déplacement (Drive) > Options de déplacement (Drive with Options)

Elément

descriptions

forward_time(time)

Fait avancer le Rover pendant la durée (time)
spécifiée.

backward_time(time)

Fait reculer le Rover pendant la durée (time)
spécifiée.

forward(distance," unit")

Fait avancer le Rover a la vitesse par défaut
sur la distance spécifiée.

La distance peut étre spécifiée en unités de
grille, en métres ou en tours de roue (unit).

backward(distance,"unit")

Fait reculer le Rover a la vitesse par défaut
sur la distance spécifiée.

La distance peut étre spécifiée en unités de
grille, en métres ou en tours de roue (unit).

left(angle,"unit")

Fait tourner le Rover a gauche de I’angle
spécifié.

L’angle peut étre en degrés, en radians ou
en grades.

right(angle,"unit")

Fait tourner le Rover a droite de I’angle
spécifié.

L’angle peut étre en degrés, en radians ou
en grades.

forward_time(time,speed,"rate")

Fait avancer le Rover pendant la durée (time)
spécifiée et a la vitesse (speed) spécifiée.

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.

backward_time(time,speed,"rate")

Fait reculer le Rover pendant la durée (time)
spécifiée et a la vitesse (speed) spécifiée.

La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.

forward(distance,"unit",speed,"rate")

Fait avancer le Rover sur la distance spécifiée
et a la vitesse (speed) spécifiée.

La distance peut étre spécifiée en unités de
grille, en metres ou en tours de roue (unit).

La vitesse peut étre spécifiée en unités de
grille/s, en meétres/s ou en tours de roue/s.

backward(distance,"unit",speed,"rate")

Fait reculer le Rover sur la distance spécifiée
et a la vitesse (speed) spécifiée.
La distance peut étre spécifiée en unités de
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Elément descriptions
grille, en métres ou en tours de roue (unit).
La vitesse peut étre spécifiée en unités de
grille/s, en métres/s ou en tours de roue/s.
Entrées
Elément descriptions

ranger_measurement()

Lit le capteur de distance a ultrasons situé a I’avant
du Rover et renvoie la distance courante en metres.

color_measurement()

Retourne une valeur comprise entre 1 et 9,
indiquant la couleur prédominante « vue » par le
capteur colorimétrique d’entrée du Rover.

1 = rouge

2 = vert

3 =bleu

4 = cyan

5 = magenta
6 = jaune

7 = noir

8 = gris

9 = blanc

red_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de rouge pergu par le capteur
colorimétrique d’entrée.

green_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de vert pergu par le capteur
colorimétrique d’entrée.

blue_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de bleu pergu par le capteur
colorimétrique d’entrée.

gray_measurement()

Renvoie une valeur comprise entre 0 et 255 qui
indique le niveau de gris percu par le capteur
colorimétrique d’entrée.

encoders_gyro_measurement()

Renvoie une liste de valeurs qui contient le
comptage des encodeurs des roues gauche et droite
ainsi que le cap gyroscopique courant.

gyro_measurement()

Renvoie une valeur qui représente la lecture
courante du gyroscope, y compris la dérive, en
degrés.
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Elément

descriptions

ranger_time()

Renvoie le temps pris par le signal ultrasonique du
capteur de distance TI-Rover pour atteindre I’objet
(le « temps de vol »).

Sorties

Elément

descriptions

color_rgb(r,g,b)

Régle la couleur de la DEL RGB du Rover
sur les valeurs spécifiées de rouge, vert
et bleu (r,g,b).

color_blink(frequency,time)

Définit la fréquence (frequency) et la
durée (time) de clignotement pour la
couleur sélectionnée.

color_off()

Eteint la DEL RGB du Rover.

motor_left(speed,time)

Régle la puissance du moteur gauche ala
valeur (speed) spécifiée pour la durée
(time) spécifiée.

La vitesse est comprise entre -255 et
255, 0 correspondant a I’arrét. Les
valeurs de vitesse positives
correspondent a une rotation dans le
sens inverse des aiguilles d’'une montre
et les valeurs de vitesse négatives a une
rotation dans le sens des aiguilles d’une
montre.

Le parametre optionnel de durée (time),
s'il est spécifié, a une plage valide de
0,05 a 655,35 secondes. S'il n’est pas
spécifié, une valeur par défaut de

5 secondes est utilisée.

motor_right(speed,time)

Regle la puissance du moteur gauche a la
valeur (speed) spécifiée pour la durée
(time) spécifiée.

La vitesse est comprise entre -255 et
255, 0 correspondant a I’arrét. Les
valeurs de vitesse positives
correspondent a une rotation dans le
sens inverse des aiguilles d’'une montre
et les valeurs de vitesse négatives a une
rotation dans le sens des aiguilles d’'une
montre.

Le paramétre optionnel de durée (time),
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Elément descriptions

s'il est spécifié, a une plage valide de
0,05 a 655,35 secondes. S'il n’est pas
spécifié, une valeur par défaut de

5 secondes est utilisée.

motors("ldir",left_val,"rdir",right_val,time) | Regle la roue gauche et la roue droite
sur les niveaux de vitesse spécifiés, pour
une durée (time) en secondes
optionnelle.

Les valeurs de vitesse (left_val, right_val)
sont comprises entre 0 et 255, 0
correspondant a l’arrét. Les parameétres
Idir et rdir spécifient la rotation en sens
horaire ou en sens antihoraire des roues
respectives.

Le parametre optionnel de durée (time),
s'il est spécifié, a une plage valide de
0,05 a 655,35 secondes. S'il n’est pas
spécifié, une valeur par défaut de

5 secondes est utilisée.

Chemin

Elément descriptions

waypoint_xythdrn() Lit I'abscisse x, I'ordonnée vy, la durée, la direction, la distance
parcourue, le nombre de tours de roue, le numéro de
commande au point de cheminement courant. Renvoie une
liste avec toutes ces valeurs en tant qu'éléments.

waypoint_prev Lit I'abscisse x, I'ordonnée v, la durée, la direction, la distance
parcourue, le nombre de tours de roue, le numéro de
commande au point de cheminement précédent.

waypoint_eta Renvoie le temps estimé pour se rendre a un point de
cheminement.

path_done() Renvoie une valeur 0 ou 1 selon que le Rover est en
mouvement (0) ou qu’il est complétement immobilisé (1).

pathlist_x() Renvoie une liste des valeurs de x depuis le début jusqu’a la
valeur de x au point de cheminement courant comprise.

pathlist_y() Renvoie une liste des valeurs de y depuis le début jusqu’a la
valeur de y au point de cheminement courant comprise.

pathlist_time() Renvoie une liste des temps en secondes depuis le début
jusqu’au temps au point de cheminement courant compris.
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Elément

descriptions

pathlist_heading()

Renvoie une liste des directions depuis le début jusqu’a la
valeur de la direction au point de cheminement courant
comprise.

pathlist_distance()

Renvoie une liste des distances parcourues depuis le début
jusqu’a la valeur de la distance au point de cheminement
courant comprise.

pathlist_revs()

Renvoie une liste du nombre de tours de roue effectués depuis
le début jusqu’a la valeur du nombre de tours de roue au point
de cheminement courant compris.

pathlist_cmdnum()

Renvoie une liste de numéros de commande pour le chemin.

waypoint_x()

Renvoie |'abscisse x du point de cheminement actuel.

waypoint_y()

Renvoie I'ordonnée y du point de cheminement actuel.

waypoint_time()

Renvoie le temps de parcours entre le point de cheminement
précédent et le point de cheminement courant.

waypoint_heading()

Renvoie la direction absolue du point de cheminement courant.

waypoint_distance()

Renvoie la distance parcourue entre le point de cheminement
précédent et le point de cheminement courant.

waypoint_revs()

Renvoie le nombre de tours de roue nécessaires pour parcourir
la distance entre le point de cheminement précédent et le
point de cheminement courant.

Parameétres
Elément descriptions
unités/s Option : vitesse en unités de grille par seconde.
m/s Option : vitesse en métres par seconde.
tr/s Option : vitesse en tours de roue par seconde.
unité Option : distance en unités de grille.
m Option : distance en meétres.
tr Option : distance en tours de roue.
Degré Option : virage en degrés.
radians Option : virage en radians.
grades Option : virage en grades.
sens horaire Option : spécification du sens de rotation de la roue.
sens antihoraire Option : spécification du sens de rotation de la roue.
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Commandes

Ces commandes sont un ensemble de fonctions provenant d’autres modules ainsi que
du module Tl Rover.

Elément descriptions

sleep(seconds) Interrompt le programme pendant le nombre spécifié
de secondes.

Importées du module time.

text_at(row,"text","align") Affiche le texte (text) dans la zone graphique avec
I’alignement (align) spécifié.
Importées du module ti_plotlib.

cls() Efface I’écran de la console (Shell) pour une
représentation graphique.
Importées du module ti_plotlib.

while get_key() != "esc": Exécute les commandes dans la boucle « while » jusqu’a
ce que la touche d’échappement « esc » soit enfoncée.

wait_until_done() Met le programme en pause jusqu’a ce que le Rover
termine la commande en cours.

Cela permet de synchroniser les commandes non Rover
avec les mouvements du Rover.

while not path_done() Exécute les commandes dans la boucle « while » jusqu’a
ce que le Rover ait terminé tous ses mouvements.

La fonction path_done() renvoie 0 ou 1 selon que le
Rover est en mouvement (0) ou qu’il est completement
immobilisé (1).

position(x,y) Définit la position du Rover sur la grille virtuelle aux
coordonnées x,y spécifiées.

position(x,y,heading,"unit") | Définit la position du Rover sur la grille virtuelle aux
coordonnées x,y spécifiées. Si une direction (heading)
est fourni (dans I'unité d’angle [unit] spécifiée), le cap
virtuel est fixé par rapport a |’axe x virtuel.

Les angles positifs de 0 a 360 sont considérés comme
étant dans le sens antihoraire par rapport a I’axe x
positif. Les angles négatifs de 0 a -360 sont considérés
comme étant dans le sens horaire par rapport a I’axe x
positif.

grid_origin() Définit le RV comme étant a |'origine de la grille
actuelle, point (0,0).

grid_m_unit(scale_value) Définit le quadrillage virtuel en métres par unité
(m/unité) a la valeur spécifiée. 0,1 constitue I’échelle
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Elément

descriptions

(en m/unité) par défaut : 1 unité = 100 mm ou 10 cm ou
1dmou0,1 m.

La plage des valeurs d’échelle (scale_value) valides est
comprise entre 0,01 et 10,0.

path_clear()

Efface toutes les informations de chemin ou points de
cheminement préexistants.

zero_gyro()

Réinitialise le gyroscope du Rover a I'angle nul et efface
les compteurs des encodeurs des roues gauche et
droite.
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Menu nombres complexes (Complex Math)

Ce sous-menu est situé sous Plus de modules (More Modules).

Elément

descriptions

from cmath import *

Importe toutes les méthodes du module cmath.

complex(real,imag)

Donne un nombre complexe.

rect(modulus,argument)

Convertit les coordonnées polaires d’'un nombre complexe
en coordonnées cartésiennes.

.real Renvoie la partie réelle du nombre complexe.

.imag Renvoie la partie imaginaire du nombre complexe.

polar() Convertit les coordonnées cartésiennes d’un nombre
complexe en coordonnées polaires.

phase() Renvoie I'argument d’un nombre complexe.

exp() Renvoie e**x.

cos() Renvoie le cosinus d’un nombre complexe.

sin() Renvoie le sinus d’'un nombre complexe.

log() Renvoie le logarithme népérien d’'un nombre complexe.

log10() Renvoie le logarithme en base 10 d'un nombre complexe.

sqrt() Renvoie la racine carrée d’un nombre complexe.
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Menu Time

Ce sous-menu est situé sous Plus de modules (More Modules).

Elément

descriptions

from time import *

Importe toutes les méthodes du module time.

sleep(seconds)

Interrompt le programme pendant le nombre spécifié de
secondes.

clock()

Retourne le temps courant du processeur sous la forme d’un
nombre flottant exprimé en secondes.

localtime()

Convertit un temps exprimé en secondes depuis le ler janvier
2000 en un tuple de neuf éléments contenant : I'année, le mois,
le jour du mois, I’heure, la minute, la seconde, le jour de la
semaine, le jour de I'année et un indicateur de I'heure d’été
(Daylight Savings Time, DST).

Si I’argument optionnel (secondes) n’est pas fourni, alors
I’horloge temps réel est utilisée.

ticks_cpu()

Retourne un compteur croissant (en millisecondes) spécifique au
processeur (cpu) avec un point de référence arbitraire.

Pour mesurer le temps de maniére cohérente a travers
différents systémes, utilisez ticks_ms().

ticks_diff()

Mesure la période entre deux appels consécutifs a la fonction
ticks_cpu() ou ticks_ms().

Cette fonction ne doit pas étre utilisée pour mesurer des
périodes de temps longues.
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Menu TI System

Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Partage de données (Data Sharing). Ceci
garantit que tous les modules nécessaires sont importés.

Elément

descriptions

from ti_system import *

Importe toutes les méthodes (fonctions) du module ti_
system.

recall_value("name")

Rappelle la valeur (value) d'une variable prédéfinie de
I’0S nommée "name".

store_value("name",value)

Stocke la valeur (value) d'une variable Python dans une
variable de I'0S nommée "name".

recall_list("name"

Rappelle une liste prédéfinie de I'OS nommée "name".

store_list("name", list)

Stocke une liste Python (list) dans une variable de type
liste de I'OS nommée "name".

eval_function("name",value)

Evalue une fonction prédéfinie de I'0S a la valeur
spécifiée.

get_platform()

Retourne « hh » pour la calculatrice et « dt » pour
I’ordinateur de bureau.

get_key()

Retourne une chaine représentant la touche enfoncée.
La touche « 1 » retourne « 1 », la touche
d’échappement retourne « esc », etc.

Lorsque la fonction est appelée sans paramétres (get_
key()), elle retourne immédiatement la chaine de
caracteres vide ("').

Lorsque la fonction est appelée avec un parametre
(get_key(1)), elle attend qu’une touche soit enfoncée.

get_mouse()

Retourne les coordonnées de la souris sous la forme
d’un tuple a deux éléments,

soit la position du pixel de la zone de tracé, soit (-1,-1)
si la position est a I’extérieur de la zone de tracé.

while get_key() != "esc":

Exécutez les commandes dans la boucle « while »
jusqu’a ce que la touche d’échappement « esc » soit
enfoncée.

clear_history()

Efface I’historique de la console (Shell).

get_time_ms()

Retourne le temps en millisecondes avec une précision
de I"ordre de la milliseconde.

Cette fonctionnalité peut étre utilisée pour calculer
une durée plutot que de déterminer I’heure effective
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Elément descriptions

de I'horloge.
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Menu Tl Draw

Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Graphiques Géométrie (Geometry
Graphics). Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from ti_draw import * Importe toutes les méthodes du module ti_draw.
Figure

Elément descriptions

draw_line() Trace un segment de droite partant du point de coordonnées

spécifiées x1,y1 jusqu’a point de coordonnées x2,y2.

draw_rect()

Trace un rectangle a partir du point de coordonnées x,y spécifiées de
largeur et de hauteur spécifiées.

fill_rect()

Trace un rectangle a partir du point de coordonnées x,y spécifiées de
largeur et de hauteur spécifiées et avec la couleur de remplissage
spécifiée (via le parameétre set_color ou noir si la couleur n’est pas
définie).

draw_circle()

Trace un cercle de centre le point de coordonnées x,y spécifiées et de
rayon spécifié.

fill_circle()

Trace un cercle de centre le point de coordonnées x,y spécifiées et de
rayon spécifié et avec la couleur de remplissage spécifiée (via le
parameétre set_color ou noir si la couleur n’est pas définie).

draw_text()

Trace une chaine de texte a partir du point de coordonnées x,y
spécifiées.

draw_arc() Trace un arc a partir du point de coordonnées x,y spécifiées de largeur,
hauteur et d’angle spécifiés.

fill_arc() Trace un arc a partir du point de coordonnées x,y spécifiées de largeur,
hauteur et d’angle spécifiés et avec la couleur de remplissage spécifiée
(via le parameétre set_color ou noir si la couleur n’est pas définie).

draw_poly() Trace un polygone en utilisant les listes d'abscisses x et d'ordonnéesy
spécifiées.

fill_poly() Trace un polygone en utilisant les listes d'abscisses x et d'ordonnéesy
spécifiées et avec la couleur de remplissage spécifiée (via le parametre
set_color ou noir si la couleur n’est pas définie)..

plot_xy() Trace une forme en utilisant les coordonnées x,y spécifiées et un
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Elément descriptions

nombre spécifié compris entre 1 et 13 qui représente différentes
formes et symboles (voir ci-dessous).

plot_xy symbols

...... X X 1o

123456789 10111213

Controle (Control)

Elément descriptions

clear() Efface la totalité de I’écran. Peut étre utilisé avec les parameétres
(x,y,largeur,hauteur) pour effacer une zone rectangulaire donnée.

clear_rect() Efface le rectangle situé aux coordonnées x,y spécifiées de largeur
et hauteur spécifiées.

set_color() Définit la couleur de la ou des formes qui suivent dans le
programme jusqu’a ce qu’une autre couleur soit définie.

set_pen() Définit I’épaisseur et le style spécifiés de la bordure pour le tracé
des formes (non applicable en cas d’utilisation de commandes de
remplissage).

set_window() Définit la taille de la fenétre dans laquelle toutes les formes
seront tracées.

Cette fonction est utile pour redimensionner la fenétre afin

qu’elle corresponde aux données ou pour modifier I’origine (0,0)
de la zone de dessin.

get_screen_dim() | Retourne les dimensions xmax et ymax de I’écran.

use_buffer() Active une mémoire tampon hors écran pour accélérer le tracé.

paint_buffer() Affiche le tracé en mémoire tampon.

Les fonctions use_buffer() et paint_buffer() sont utiles lorsque
I’affichage de plusieurs objets a I’écran risque de provoquer des
problémes de ralentissements.

Editeur mathématique

e La configuration par défaut attribue les coordonnées (0,0) au coin supérieur gauche
de I’écran. L'axe des x positifs pointe vers la droite et I’axe des y positifs pointe
vers le bas. Cela peut étre modifié via la fonction set_window().
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e Les fonctions du module ti_draw sont uniquement disponibles sur la calculatrice ou
sur la vue calculatrice de I'ordinateur de bureau.
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Menu Tl Image
Ce sous-menu est situé sous Plus de modules (More Modules).

Remarque : Lors de la création d’un nouveau programme qui utilise ce module, il est
recommandé d’utiliser le type de programme Traitement d’image (Image Processing).
Ceci garantit que tous les modules nécessaires sont importés.

Elément descriptions

from ti_image import * Importe toutes les méthodes du module ti_image.

new_image(width,height,(r,g,b)) | Crée une nouvelle image avec la largeur (width) et
la hauteur (height) spécifiées pour I'utiliser dans le
programme Python.

La couleur de la nouvelle image est définie par les
valeurs (r,g,b).

load_image("name" Charge I'image spécifiée par son nom (name) pour
une utilisation dans le programme Python.

L’image doit faire partie du classeur TNS, soit dans
une application Editeur mathématique ou
Graphiques.

L’'invite « nom » (name) affiche les noms des images

(si elles ont été nommées auparavant) ou un
numéro indiquant leur ordre d’insertion.

copy_image(image) Crée une copie de I'image spécifiée par la variable
« image ».

Méthodes de I'objet image

Des fonctions supplémentaires concernant les objets images sont disponibles dans
|’éditeur et la console en tapant le nom de la variable suivi d’un . (point).

@ *zpy 5/5

from ti_image import *

R ge_pixel(xy)
set_pixel(x,y,color_tuple)
show_image(x,y)

e get_pixel(x,y): Donne la valeur (r,g,b) du pixel a I'emplacement défini par la paire
de coordonnées (x,y).

px val = get pixel(100,100)
print (px val)

e set_pixel(x,y,color_tuple): Définit la couleur du pixel spécifiée par un tuple (color_
tuple) a I'emplacement (x,y).

set pixel (100,100, (0,0,255))

Regle le pixel de coordonnées (100,100) a la couleur (0,0,255).
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¢ show_image(x,y): Affiche I'image avec le coin supérieur gauche a I'emplacement
(xy).

e w, h, name: Permet d’obtenir les parametres largeur (w), hauteur (h) et nom
(name) de I'image.

Par exemple
from ti image import *

# An image has been previously inserted into the TNS document in a
Notes application and named "bridge"

iml=load image ("bridge")

px val = iml.get pixel (100,100)

print (px_val)

# Set the pixel at 100,100 to blue (0,0,255)
iml.set pixel (100,100, (0,0,255))

new px = iml.get pixel(100,100)

priﬁt (new_px)

# Print the width, height and name of the image
print (iml.w, iml.h, iml.name)
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Menu Variables

Remarque : Ces listes ne comprennent pas les variables définies dans d’autres

applications TI-Nspire™.

Elément

descriptions

Vars : Programme en cours

(éditeur uniquement) Affiche une liste de
fonctions et de variables globales définies dans le
programme en cours

Vars: Dernier programme exécuté

(console uniquement) Affiche une liste de
fonctions et de variables globales définies dans le
programme en cours

Vars: Tout

(console uniquement) Affiche une liste de
fonctions et de variables globales du dernier
programme exécuté et de tous les modules
importés
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Mots-clés Python

Les mots-clés suivants sont intégrés a I'implémentation de Python dans TI-Nspire™.

False elif lambda
None else nonlocal
True except not
and finally or

as for pass
assert from raise
break global return
class if try
continue import while
def in with
del is yield
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Mappage des touches dans Python

Lors de la saisie du code dans I’éditeur ou dans la console, le clavier est congu pour
coller les opérations Python appropriées ou ouvrir des menus afin de faciliter la saisie
de fonctions, de mots-clés, de méthodes, d’opérateurs, etc.

Touche Mappage
var Ouvre le menu Variables
Stos, Colle le signe =
del Supprime le caractére a gauche du curseur
lear Aucune action
= Colle le signe =
T2 Colle le ou les symboles sélectionnés :
. >
. <
. I=
° >=
° <=
L] ==
e et
e —ou—
¢ non
.«
¢ &
. ~
Colle la fonction sélectionnée :
e sin
* cos
e tan
e atan2
e asin
e acos
e atan
@ Affiche des conseils
= Colle :=
Colle **
e Aucune action
() Colle **2
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Touche Mappage

v Colle sqrt()
) Colle le signe de multiplication (*)
Colle un guillemet anglais (")
= Colle le signe de division (/)
[%] Aucune action
Colle exp()
“in’ Colle log()
Colle 10**
Tlog. Colle log(value,base)
[ Colle (
0 Colle )
o’ Colle []
K3 Colle { }
=) Colle le signe moins (-)
= Ajoute une nouvelle ligne apreés la ligne courante
23] Colle E
2> Colle le ou les symboles sélectionnés :
¢ ?
o |
L
. ©
.
c %
o
L]
*
* —
e\
o« #
Colle « pi »
& Etat courant de I'indicateur (flag)
Ajoute une nouvelle ligne aprés la ligne courante
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Exemples de programmes Python

Utilisez les exemples de programmes suivants pour vous familiariser avec les
méthodes Python. IIs sont également disponibles dans le fichier Getting Started
Python.tns situé dans le dossier Exemples (Examples).

Remarque : Si vous copiez et collez un exemple de code contenant des indicateurs
d’indentation par tabulation (- <) dans le logiciel TI-Nspire™, vous devrez remplacer
ces instances par de véritables indentations par tabulation.

Bonjour

# This program asks for your name and uses
# it in an output message.
# Run the program here by typing "Ctrl R"

name=input ("What's your name? ")
print ("Hello, ", name)
print ("\n Press ctrl+R to run again")

*Doc

[ Python Shell 77
>>>#Running Sample.py

>>>from Sample import *

\What's your name? Thormas

Helo, Thomas

5>

Press ctrl+R to run again
55>
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Exemple de boucle

# This program uses a "for" loop to calculate
# the squares and cubes of the first 5 numbers
#0,1,2,3,4

# Note: Python starts counting at 0

for index in range (5):
square = index**2
cube = index**3
print ("Index: "

"Cube: ", cube)

index, "Square: ", square,

>>>#Running Sample.py
>>>from Sample import *

0 Square: 0 Cube:
1 Square: 1 Cube:
2 Square: 4 Cube:
3 Square: 9 Cube:
4 Square: 16 Cube: 64

nooo
S
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Pile ou face

# Use random numbers to simulate a coin flip
# We will count the number of heads and tails
# Run the program here by typing "Ctrl R"

# Import all the functions of the "random" module
from random import *

# n is the number of times the die is rolled
def coin flip(n):
heads = tails = 0
for i in range(n):
# Generate a random integer - 0 or 1
# "0" means head, "1" means tails
side=randint (0, 1)
if (side == 0):
heads = heads + 1
else:
tails = tails + 1
# Print the total number of heads and tails
print(n, "coin flips: Heads: ", heads, "Tails:

n
’

tails)

print ("\nPress the Var key and select 'coin flip()'")

print ("In the ( ), enter a number of flips!")

Doc

(@ Python Shell 88
>>>#Running Sample.py

>>>from Sample import *

>0

Press the Var key and select ‘cain_flipt)’

Inthe (), enter a number of flips!
>>>coin_flip(10)

10 coin flips: Heads: 4 Tails: 6

ESSN
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Graphe

# Plotting example
import ti plotlib as plt

# Set up the graph window
plt.window(-10,10,-10,10)

plt.axes ("on")

plt.grid (1,1, "dashed")

# Add leading spaces to position the title
plt.title (" TITLE")

# Set the pen style and the graph color
plt.pen ("medium", "solid")
plt.color(28,242,221)
plt.line(-5,5,5,-5,"arrow")

plt.pen("thin", "dashed")
plt.color (224,54,243)
plt.line(-5,-5,5,5,"")

# Scatter plot from 2 lists
plt.color(0,0,0)
xlist=[1,2,3,4,5]
ylist=[5,4,3,2,1]
plt.scatter (xlist,ylist, "x")

10 TTLE
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Tracé

from ti draw import *

# (0,0) is in top left corner of screen

# Let's draw some circles and squares

# Circle with center at (50,50) and radius 40
draw circle(50,50,40)

# Set color to red (255,0,0) and fill a rectangle of
# of width 180, height 80 with top left corner at

# (100,100)

set color(255,0,0)

fill rect(100,100,180,80)

# Set color to green and pen style to "thin"
# and "dotted".

# Then, draw a circle with center at (200,100)
# and radius 40

set color(0,255,0)

set pen("thin", "dotted")

draw circle(200,100,40)

set color(0,0,0)
draw_text (20,200, "Press Enter to exit")

O
]

Press Enter to exit
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Image

# Image Processing

n

#

from ti_image import *
from ti draw import *

i
it

# Load and show the 'manhole cover' image
# It's in a Notes app

# Draw a circle on top
iml=load image ("manhole cover")

iml.show image (0,0)

set_color (0,255,0)

set pen("thick","dashed")

draw circle(140,110,100)

65 Annexe



Hub

Ce programme utilise Python pour contréler un TI-Innovator™ Hub, un microcontréleur
programmable. Si vous exécutez le programme sans connecter un Tl-Innovator™ Hub,
un message d’erreur apparaitra.

Pour plus d'informations sur le Tl-Innovator™ Hub, rendez-vous sur education.ti.com.

#========== Import Section ==========
from ti_hub import *

from math import *

from random import *

from time import sleep

from ti plotlib import text at,cls

from ti system import get key

#======== End of Import Section =======

print ("Connect the TI-Innovator Hub and hit 'enter'")
input ()

print ("Blinking the RGB LED for 4 seconds")

# Set the RGB LED on the Hub to purple
color.rgb(255,0,255)

# Blink the LED 2 times a second for 4 seconds
color.blink(2,4)

sleep (5)
print ("The brightness sensor reading is: ", brightness.measurement ()

# Generate 10 random colors for the RGB LED
# Play a tone on the Hub based on the random
# color
print ("Generate 10 random colors on the Hub & play a tone")
for i in range(10):

r=randint (0, 255)

b=randint (0, 255)

g=randint (0,255)

color.rgb(r,qg,b)

sound.tone ( (r+g+b) /3,1)

sleep (1)

color.off ()
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https://education.ti.com/

Informations générales

Aide en ligne

education.ti.com/eguide

Sélectionnez votre pays pour obtenir d'autres informations relatives aux produits.

Contacter I’assistance technique TI

education.ti.com/ti-cares

Sélectionnez votre pays pour obtenir une assistance technique ou d'autres types de
support.

Informations Garantie et Assistance

education.ti.com/warranty

Sélectionnez votre pays pour en savoir plus sur la durée et les termes de la garantie et
sur I’assistance pour le produit.

Garantie limitée. Cette garantie n'affecte pas vos droits statutaires.
Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243
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